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Audience
This manual is intended for specifiers, users and installers of the Sontay® SonNet radio sensor system.
Content

This manual provides a complete reference for the Sontay® SonNet radio Site Survey system.

Related Documents

The Sontay® SonNet radio sensor system Site Survey Kit Quick Start Guide
The Sontay® SonNet radio sensor system User Manual

The Sontay® SonNet radio sensor system Quick Start Guide

The Sontay® SonNet radio sensor system product datasheets
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Overview

The wireless nodes are based on direct-sequence spread spectrum (DSSS) communication in the 2.4 - 2.5GHz
band, compliant with IEEE 802.15.4-2006.

All nodes have a unique MAC address, equivalent to a unique serial number.
All nodes have a PCB-mounted on/off switch or jumper.
All nodes retain their configuration properties across a power failure.

Environmental

o Storage temperature range of -10 to +80°C

. Storage relative humidity range of 0 to 90% (non-condensing).

o Ambient (operating) temperature range of -10°C to +70°C

. Ambient (operating) relative humidity range of 0 to 90%, (non-condensing).

Battery Charging

To charge the battery in an SSK (site survey kit) node, connect the correct charger to the socket on the back
plate. The status LED on the charger will show red until the battery is fully charged, when the status LED will
turn green.

To charge the battery in an SSK router, connect the correct charger to the socket mounted on the side of the
housing. The status LED on the charger will show red until the battery is fully charged, when the status LED will
turn green. NB - the same charger type is used for both SSK nodes and SSK routers.

To charge the battery in the HHM (hand held monitor), connect the correct charger to the socket located on
the bottom of the housing. The status LED visible through the HHM keypad will show orange until the battery
is fully charged, when the status LED will go out.

To charge the battery in an SSK receiver, connect the correct charger to the charger socket. The status LED on
the charger will show red until the battery is fully charged, when the status LED will turn green.

Note that when charging SSK batteries, the electronics are disconnected from the rest of the device, and
therefore that device will not function until charging is complete. Only the battery is connected to the charger.

Only the correct chargers must be used for each SSK device. Batteries will be damaged if not charged by the
correct charger.
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SSK Functional Overview
The Sontay® SonNet Site Survey Kit (SSK) is designed to make the design and installation of a SonNet radio
sensor system simple and quick and to take the guesswork out of the radio communications aspect of the

network.

The SSK receiver should be placed where the actual RF-RX system receiver will be installed (typically in a plant
room or riser).

The hand-held monitor (HHM) communicates with the SSK receiver (via a router, if necessary), and the LCD
display shows which nodes are on-line and the quality of the radio link to their “parent” devices.

Follow the step-by-step guide to determine where to position the receiver, any routers necessary, and to test
that all sensor nodes can communicate with the receiver reliably when installed.

The SSK is housed in a robust case, and contains:

o 1 x SSK receiver

o 1 x hand-held monitor (HHM)

. 4 x battery powered SSK sensor nodes

. 2 x SSK routers

. 1 x charger unit for the SSK receiver

. 1 x charger unit for the HHM

o 2 x charger units for the SSK nodes and routers
o SSK Quick Start Guide

o SSK User Manual
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Using the SSK

Place the SSK receiver where the final system receiver will be installed. Switch on the SSK receiver. Place SSK
nodes where final system end device nodes will be installed. Switch on the SSK nodes.

Switch on the HHM.
The HHM displays all on-line routers and sensors on the radio system.

After initialisation, the LCD will display a list of devices which are connected directly to the receiver, together
with their link quality index (LQl).

Where a listed device is a router, to the right of that device will be a number which denotes the number of
“children” the device has.

To get further information about a device, use the Up/Down arrow keys to select that device, then press the
right arrow key to view more detailed information.

To display the MAC address and firmware revision number, use the right arrow key to select “more” then press
the OK key.

To go back to the main device list, use the Up/Down arrow keys to select “back”, then press the OK key.
Verification Mode

Verification mode is a special mode that an SSK node or router can adopt specifically to test the LQl to another
device. In this special mode, the device ignores the normal hierarchical rules used to form a robust network,
and relies solely on signal strength. When a device is requested to go into verification mode, it will briefly drop
off the radio network and, having rebooted, reappear running in verification mode. Note that a device placed
in to verification mode will automatically reboot back into normal mode after 5 minutes if left unattended.
Power-cycling a device in verification mode will also return that device to normal mode.

To place a device in verification mode, select the device from the list by using the Up/Down arrow keys, then
press the right arrow key. Using the Up/Down arrow keys to select “verify”, then press the OK key. The device
will go off-line for a few seconds, before re-joining the network in verification mode.

Switch off the HHM.

1. Ensure that the SSK receiver, HHM, and special battery powered SSK routers and nodes are
fully charged. Always use the correct chargers provided to for each device. Batteries will be
damaged if not charged by the correct charger.

2. Place the SSK receiver where the system receiver will be placed, ensuring that the aerial is
aligned vertically if possible.

3. Switch on the SSK receiver.
4, Switch on the HHM. After a brief period, the LCD display will show the HHM in the device list.
5. Place the battery powered sensor nodes where required by the site specification, taking care
to ensure that the sensors are not placed;
a. In direct sunlight or near a source of heat
b. On a cold or hot outside wall, where conducted or radiant heat may affect the
reading
c. Behind any obstruction likely to impede the radio signal (for example, a filing
cabinet)
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Notes:

Using the HHM, observe whether each battery powered sensor node has communication
back to the SSK receiver. If it does, observe the link quality, shown on the LCD display.

a. If the link quality is shown as good or v. good, no router is required for this node. Go
to step 7.

b. If there is no communication, or link quality is shown as marginal to the SSK
receiver, you will need to position a router between the node and receiver.

c. In this case, position a router between the node and receiver in a convenient

location, remembering that a system router in the final installation will require a
permanent 24Vac/dc supply.

d. Observe the HHM again. The new router should be registered on the HHM.

e. Using the HHM, observe the link quality for the new router to the receiver. If the
link is shown as good, proceed to step 6f. If the link quality is shown as marginal,
select the new router and then navigate to “Verification” on the HHM menu. Press
the OK key to force the new router into verification mode. The node will go off-line
for a short period, then re-join in verification mode. The router will now try to find a
better communications path back to the receiver via another router, if there is one
already installed. Note the link quality and the position of the router. It is
recommended that a drawing or floor plan be used to mark device positions.

f. Using the HHM, select the node and then navigate to “Verification” on the HHM
menu. Press the OK key to force the new node into verification mode. The node will
go off-line for a short period, then re-join in verification mode. Note the link quality
and the exact position of the router.

g. Where a router or node has been placed into verification mode, it must be returned
to normal operating mode by resetting or power cycling prior to moving to step 7. If
left unattended for more than 5 minutes, a router or node placed into verification
mode will automatically return to normal mode.

Continue placing battery powered sensor nodes (and routers if required), until battery
powered sensor nodes have been tested at the required points, good quality links are shown
for all devices on the HHM, and complete coverage is demonstrated.

In the final installation, routers can also be sensors. However, they require a permanent
24Vac/dc supply.

Each router can support a maximum of 16 “children”, which can consist of a maximum of 8
battery powered nodes and 8 routers, or up to 16 routers if there are no battery powered
end devices (EDs). In most circumstances, it is advised that, unless unavoidable, no more
than 8 “children” should be connected to a single router, to allow for redundancy in case of
router failure or damage.

SSK nodes are fitted with a thermistor temperature element, and will report temperature
and battery status to the HHM or CMS (configuration and monitoring software). SSK routers
are not fitted with temperature sensing elements, and will only report link qualities and
battery status.
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Battery Fitting and Replacement

When a battery is first installed, or when it is replaced, observing the correct polarity is very important. Fitting
the battery incorrectly may result in permanent damage to the sensor.

Recommended batteries are:

Nodes and routers: 3.7V Lithium Polymer, rechargeable 1080mAh
(Uniross U0110952)

Hand Held Monitor (HHM): 3.6V NiMH, rechargeable 580mAh
(vVarta 3/V600HR WIRE)

SSK Receiver: 12V NiMH, 2100mAh, 10 x AA cell rechargeable pack (Strikalite 752)
Batteries should be stored in a clean, cool (not exceeding +30°C), dry and ventilated area.
Disposal of Batteries - Warning! Fire, Explosion and Burn Hazard

Do not short-circuit, crush, disassemble, heat above 100°C (212°F), incinerate, or expose the battery contents
to water. Do not solder directly to the cell.

All batteries must be disposed of in accordance with EC Directive 2006/66/EC, amended by EU Directive
2008/12/EC.

SSK Part Codes:

RF-SSK — Site Survey Kit

RF-RXSS - Receiver module (no outputs)
RF-HHT - Handheld monitor

RF-TS-900 - Temperature SSK sensor
RF-PS-500 - SSK Router
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SSK Nodes

RF-TS-900 nodes are used in conjunction with the Sontay® RF-RXSS receiver, RF-PS-500 routers and RF-HHT
hand held monitor.

Data is transmitted back to the receiver every 30 seconds. Each sensor retains these configurations if the
battery becomes discharged or requires replacement.

NB - To preserve battery life, an SSK node will automatically go off-line after approximately 4 hours if not
power-cycled.

To charge the battery in an SSK node, connect the correct charger to the socket on the back plate. The status
LED on the charger will show red until the battery is fully charged, when the status LED will turn green.

To power an SSK node, the battery must be connected and the On/Off rocker switch on the backplate should
be switched to the On position. To switch off, the On/Off rocker switch on the backplate should be switched to
the Off position. Refer to datasheet.

The sensors automatically find the best path back to the receiver, which may be directly to the receiver or via
“parent” routers.

. SSK nodes have a thermistor temperature sensor fitted as standard.

SSK Node Specification:

Radio Output:
Frequency 2.4GHz
16 channels, automatically selected
Direct-sequence spread spectrum

Compliance IEEE 802.15.4-2006
Aerial Characteristics

Gain 1.2dBi

VSWR 1.5:1
Data Encryption: AES 128
Power Output: 0dBm
Temperature accuracy 1+0.3°C
Battery Type: 3.7V Lithium Polymer, rechargeable, 1080mAh
Housing Material: ABS (flame retardant)
Dimensions: 85x85x23mm
Environmental:
Operating:

Temperature -10°C to +50°C

RH 0 to 90%, non-condensing
Storage:

Temperature -10°C to +80°C

RH 0 to 90%, non-condensing
Country of origin: UK

Part Code: RF-TS-900

Refer to product datasheet for installation instructions.
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SSK Routers

RF-PS-500 SSK routers are used in conjunction with the Sontay® RF-RXSS receiver, RF-TS-900 nodes and RF-
HHT hand held monitor, and are used to route signals from battery powered nodes and other routers to the
receiver module, where the signal strength of a direct path is not sufficient for reliable communications.

NB Each router can support a maximum of 16 “children”, which can consist of a maximum of 8 battery
powered nodes and 8 routers, or up to 16 routers if there are no battery powered end devices (EDs).
Consideration should be given on network planning for redundancy in case of router failure or damage.

Routers automatically find the best path back to the receiver, which may be directly to the receiver or via
other “parent” routers.

NB To preserve battery life, an SSK router will automatically go off-line after approximately 4 hours if not
power-cycled.

To charge the battery in an SSK router, connect the correct charger to the socket mounted on the side of the
housing. The status LED on the charger will show red until the battery is fully charged, when the status LED will
turn green. NB - the same charger type is used for both SSK nodes and SSK routers.

To power an SSK router, the battery must be connected and the On/Off toggle switch on the housing side
should be switched to the On position. To switch off, the On/Off toggle switch on the housing side should be
switched to the Off position. Refer to datasheet.

o SSK routers do not have a temperature sensor fitted.
SSK Router Specification:
Radio Output:

Frequency 2.4GHz

16 channels, automatically selected
Direct-sequence spread spectrum

Compliance IEEE 802.15.4-2006
Aerial Characteristics
Gain 2.0dBi
VSWR <2:1
Data Encryption: AES 128
Power Output: +10dBm
Battery Type: 3.7V Lithium Polymer, rechargeable, 1080mAh
Housing:
Material ABS (flame retardant type VO)
Dimensions 55mm x 90mm dia.

Mounting holes 4mm spaced 85mm apart
Environmental:

Operating:

Temperature -10°C to +50°C

RH 0 to 90%, non-condensing
Storage:

Temperature -10°C to +80°C

RH 0 to 90%, non-condensing
Country of origin: UK

Part Code: RF-PS-500

Refer to product datasheet for installation instructions.
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The SSK Receiver
The Sontay® RF-RXSS receiver collects data from all other devices on the SSK radio network, including
measurements from sensors, link quality for all links formed in the network, battery levels for all battery

powered devices, hours run for all devices and the current status of all devices.

NB There are no analogue outputs on an RF-RXSS. The SSK receiver is used solely to determine signal strengths
and whether routers need to be added to a network to achieve complete, reliable coverage.

Data is transmitted back to the receiver at pre-configured time intervals.
A USB socket is provided for connection to a PC or laptop running the Sontay SonNet CMS software.

To power the SSK receiver, turn the On/Off switch on the housing cover to ON. To switch off, turn the On/Off
switch on the housing cover to OFF.

To charge the battery in an SSK receiver, connect the correct charger to the socket. The status LED on the
charger will show red until the battery is fully charged, when the status LED will turn green.

SSK Receiver Specification:

Radio Output:
Frequency 2.4GHz
16 channels, automatically selected
Direct-sequence spread spectrum

Compliance IEEE 802.15.4-2006
Aerial Characteristics
Gain 2.0dBi
VSWR <2:1
Data Encryption: AES 128
Power Output: +10dBm
Power Supply: Internal 12Vdc NiMH battery, 2.1Ah

Serial communications:

Environmental:

USB 2.0

Operating:

Temperature -10°C to +50°C

RH 0 to 90%, non-condensing
Storage:

Temperature -10°C to +80°C

RH 0 to 90%, non-condensing
Country of origin: UK

Part Code: RF-RXSS

Refer to product datasheet for installation instructions.
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The SSK Hand Held Monitor

The Sontay® RF-HHT displays all on-line receivers, routers and nodes in the SSK radio network, and shows link
quality for all links formed in the network, battery levels for all battery powered devices, hours run for all
devices and the current status of all devices.

To switch on the HHM, press and hold the OK key for approximately 1 second. To switch off, press and hold
the OK key for at least 2 seconds. The HHM will beep to indicate that it is shutting down.

To charge the battery in the HHM, connect the correct charger to the socket located on the bottom of the
housing. The status LED visible through the HHM keypad will show orange until the battery is fully charged,
when the status LED will go out.

SSK HHM Specification:

Radio Output:
Frequency 2.4GHz
16 channels, automatically selected
Direct-sequence spread spectrum

Compliance IEEE 802.15.4-2006
Aerial Characteristics

Gain 2.0dBi

VSWR <2:1
Data Encryption: AES 128
Power Output: +10dBm
Power Supply: Internal 3.6Vdc NiMH battery, 580mAh
Environmental:
Operating:

Temperature -10°C to +50°C

RH 0 to 90%, non-condensing
Storage:

Temperature -10°C to +80°C

RH 0 to 90%, non-condensing
Country of origin: UK

Part Code: RF-HHT

Refer to product datasheet for installation instructions.
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The Radio Network

A Sontay® SonNet radio system is comprised of a receiver, battery powered sensors and permanently powered
routers.

D Battery Powered Node L

O Router Receiver

O O

@
AN

[}
P
0 / \"‘\D
0~ o)

Routers, though permanently powered, can also have sensing elements, accomplishing both router and
sensors functions. Routers and sensors can either communicate directly with the receiver or via other routers.
Routers are required to be permanently powered as they need to stay “awake” at all times to allow signals
from “child” nodes to be instantly forwarded to their “parent” nodes. Battery powered sensors only “wake”
for very short periods to send data.

In the schematic above, router R4 has 3 children, all battery powered sensors. It’s parent is R2. Router R2 has 4
children, 3 battery powered sensors AND R4. R2’s parent is R1, which has 6 children, 4 battery powered
sensors, R2 and R3.

The receiver can support a maximum of 16 directly connected “child” devices, of which only 12 can be battery
powered nodes, plus up to 4 routers. Routers can support a maximum of 16 directly connected “child” devices,
of which only 8 can be battery powered nodes, plus up to 8 routers. There can be a maximum depth of 8 layers

in a network and a maximum of 50 nodes per network with the RF-RX series of receivers.

NB From the receiver to router R1 can be considered as a “layer”.
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Note that battery powered devices can only route their signals to the receiver directly or through routers, and
not through other battery powered devices.

When planning a SonNet radio network, it is recommend that the Sontay® SonNet Site Survey Kit be used. This
easy-to-use package allows installers to test signal strengths between locations required for battery powered
sensors and the receiver prior to installing the full system. It can also identify whether routers are needed to
ensure reliable communications between all devices on the network back to the receiiver. This removes any
guesswork from planning a system and allows the installer to order exactly and only the devices required.

See the Sontay® SonNet radio sensor system Site Survey Kit Quick Start Guide and The Sontay® SonNet radio
sensor system Site Survey Kit Manual for full details.

Network Planning Considerations

When planning a SonNet radio system, it is always worth considering the placement of routers. Routers
support a maximum of 16 children, be aware of the consequences of a router failing or being damaged.

Example:

Receiver Receiver

\DD
[
\

This network has 2

R routers and 16 battery _
powered sensors (8 per
] router) D’/ \\D

If router R2 failed or was
damaged, there would
not be enough capacity in

the router R1 to take the D D
8 “orphaned” sensors. D D
(r2)

EI o L]

//\;D i

\\
¥
\\
/7

The result would be that at least 8 “orphaned” sensors would not be able to find a route back to the receiver,
and would go off-line until their original parent R2 was replaced.
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This network has 4 routers and 16 battery powered sensors (4 per router)

If router R4 failed or was damaged in this scenario, there would be enough capacity in routers R1, R2 and R3 to
take the 4 “orphaned” sensors.

The result would be that all 4 “orphaned” sensors would still be able to find a route back to the receiver, and
would remain on-line until their original parent R4 was replaced.

Receiver
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The Radio System
The radio system used by the Sontay SonNet devices is divided into 3 sections or ‘layers’.

1. The radio layer is where physical control of the radio signal is done. This conforms to
international standard 802.15.4, and determines the frequency of the radio signals, the
number of ‘channels’ available for use, the bandwidth and power level of the signal etc.
There are 16 channels available, and the best one is automatically selected by the receiver.
The frequencies used are in the ISM (Industrial, Scientific and Medical) 2.4GHz band, with a
maximum data rate of 250kb/s.

2. The network management layer is where the self-healing tree functionality is run, which
controls network topology. ‘ZigBee’ is an example of a network management MESH protocol.
SonNet does not use ZigBee, but instead uses a ‘self-healing tree’ protocol to control
network topology.

3. The application layer is what determines what the device does — i.e. makes it a temperature
sensing device, a router or a receiver. SonNet devices use specific applications, and include
features such as configuration properties.

Security

All SonNet system devices have the same, unique network identifier. Only devices with the correct ID will be
allowed to join the network. The ID used by system devices is different from the ID used for site survey kit
(SSK) devices. Hence, SSK devices cannot join a system network and vice versa. When a SonNet system
network has been formed, it can be ‘locked’ to prevent any unauthorised devices joining, even if they are
SonNet devices. The CMS can be used to authorise extra SonNet system devices if required.

All data transmitted by SonNet devices is encrypted.
How the Self-Healing Tree Network Is Formed
The network is formed based on 3 rules, and in a specific order of priority:
1. How many ‘tiers’ a device is away from the receiver.
If a device can communicate directly with the receiver, it will, even if the link quality is
poorer than if it went through a router. If a device has a choice of more than one router, it
will always choose the router closest to the receiver (the least number of tiers away), even if
the link quality is marginal.
2. The number of ‘child’ devices a router already has.
A router can have a maximum of 16 ‘children’. If a device has a choice of more than one
router of the same tier level, it will always choose the router with the least number of
children, even if the link quality is marginal.

3. Signal Strength (link quality).

Finally, if a device has a choice of more than one router of the same tier level and the same
number of children, it will choose the router with the best link quality.

If, for any reason, a device (node or router), loses its preferred path back to the receiver, it will automatically
search for an alternative — still obeying the 3 rules above in sequence. If, despite employing Direct Sequence
Spread Spectrum (DSSS) techniques, interference on the currently occupied channel prevents communications,
the receiver will automatically look for another channel which is clear. All other devices, having lost their links
to the receiver, will then also automatically scan the 16 channels until they find the receiver again, and the
network will re-form without user intervention.
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Propagation Of Radio Signals In Buildings
The propagation of microwave radio signals in a building can be affected in several ways:

Attenuation

attenuated much more when passing through other media, such as materials
typically used in construction, such as brick, stone, wood and especially

' ‘l /\ Radio signal strength is attenuated when it passes through air. Signals are
steel.

Reflection

y

/ Depending on the building, radio signals can take many paths from the
: transmitter to the receiver, rather than just one single path.
‘Multipath’ signals can have the effect of cancelling each other out, reducing
/ overall received signal strength.
Scattering

Scattering the radio signal can also reduce it’s signal strength.
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FAQs
a. How is access to the sensor network locked at the CMS?

Nodes are only allowed to join the network if the receiver allows them to. This is true even if the nodes are
identified as SonNet Nodes and have the correct encryption key.

There are two methods to configuring the receiver to accept nodes on to the network. In order to authorise a
node the CMS must be in administration mode (File->Switch Admin Mode must be ticked).

o Auto-Commissioning Mode
The CMS allows the receiver to be switched to auto-commissioning mode. In this mode any
nodes that can correctly identify themselves as SonNet nodes will be allowed to join the
network. Any nodes that do join will be added to the CMS textual display.

. Manual Mode

In manual mode individual nodes can be removed from or added to the authorised node list
from the CMS. Manual mode is the default mode.

A node can then be authorised by Options->Authorise (add) a new node or selecting the
same option on the right click menu in the Textual or Graphical parts of the application
display.

The user must type the MAC address (on PCB and product housing) of the new node into the
dialog that appears and can also give the node a textual name (up to 10 characters)

b. Why do some menu items disappear if the CMS application is idle for some time?

The CMS has a timeout that operates when in Admin mode. If there is no activity for some time the CMS
application will exit admin mode and some admin menu items will be disabled or removed.

The timeout can be set in Options-> Change Idle Time.

Admin mode can be entered again in File->Switch Admin Mode

c. The CMS application right click menu has stopped being provided. Why?

This probably means that the CMS has detected that the receiver has been disconnected from the PC. This will
be indicated on the status bar at the bottom left side of the CMS application window "Receiver Disconnected".
In this state many of the CMS facilities are disabled until the Receiver is connected again.

d. How are the network node names stored, are they persistent?

The node names are stored in the receiver hardware in non-volatile memory. Therefore these will be the same
even if a different PC is attached to the system, or the receiver is reset / power cycled.

e. In the CMS application what is an Unknown node?
The application will list all nodes that have been added to the system as unknown initially. As soon as a node is
added (either manually or by the use of auto commissioning mode) a request is sent to it to establish what

type of node it is and what capabilities it has.

As a result a node will be categorized as unknown until a response is received from it. If the node remains off-
line or does not respond for any other reason it will remain in this category.

The CMS will send a request each time it is started if there are still unknown nodes in the system.
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Using the SSK with SonNet Configuration and Monitoring Software (CMS)
Although not necessary to undertake a site survey, CMS can be used with the SSK if required. After installing
CMS (see user manual), connect the SSK receiver to a free USB port on the CMS PC. After the drivers are

installed, CMS can be used to textually and graphically display the SSK network.

It can be used for;

o Adding or removing nodes’

o Providing a text and graphical display of the network
o Monitor device status

. Monitor link and battery quality

o View logs for receiver configuration changes

! All nodes, router and the HHM are pre-configured into the SSK receiver. No further authorization of nodes
should be needed. Note that system devices cannot be authorized in an SSK receiver.

The CMS installation procedure installs 3 components:

o Microsoft® SQL Server 2005 Express Edition SP2
o Sontay® SonNet CMS
o Sontay® device USB device drivers

NB It is important that the CMS installation be completed prior to connecting the PC to the receiver.
Important — Windows 7 Users
Prior to installing CMS, it is important to turn off driver signing.

From the Start menu, type cmd.exe in the search bar. Right click on cmd.exe and choose run as administrator.

Programs (1)
BN cmd.exe
Open
Documents %' Run as administrator
1, geprevue Pin to Taskbar
Microsoft Ol Pin to Start Menu
3 Re: Paym Restore previous versions
=i RE: Systey Send to »
4 RE: Systet
o Cut
= FormMai soon!
C
3 Re: Order Ry of ClickYes ...
1) ClickYesk Delete nber 010220...
& Re: Click} = =
gt Open file location
4 RE: Click\
= RE: Click) Properties

4 Re: ClickYes Pro Feedback Form
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Run the following commands in the shell.

bcdedit.exe -set loadoptions DDISABLE_INTEGRITY_CHECKS
bcdedit.exe -set TESTSIGNING ON

g N
B Administrator: C:\Windows\system32\cmd.exe — @M

Microsoft Windows [Uersion 6.1.76801 -
Copyright <(c> 2089 Microsoft Corporation. All rights reserved.

C:\Users\Gordon.Hold>hcdedit.exe —-set loadoptions DDISABLE_INTEGRITY_CHECKS
The operation completed successfully.

C:\Users\Gordon.Hold>hcdedit.exe —set TESTSIGNING ON
The operation completed successfully.

iC:\Users\Gordon.Hold>

v

Microsoft® SQL Server 2005 Express Edition SP2 is installed first, if not already installed,
followed by Sontay® SonNet CMS and finally the Sontay® device USB device drivers.

Note that there is an issue with SQL Server 2005 Express Edition SP2 and MSXML 6 SP2 (see Microsoft
Knowledge Base article KB954459 for full details). To overcome this, the CMS installation will offer to run the
Windows Installer Cleanup Utility to uninstall MSXML6 SP2. When this message appears, click on the <Install>
button.

' SonNet CMS Setup

The following components will be installed on your machine:

MSXMLE SP2 / SOLExpress 2005 Cleanup

Do you wish to install these components?

If you choase Cancel, setup will exit.

Install
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Installing CMS

 SonNet CMS Setup @

For the following components:

SQL Server 2005 Express Edition SP2

Please read the following license agreement. Press the page down key to
see the rest of the agreement.

MICROSOFT SOFTWARE SUPPLEMENTAL LICENSE TERMS A
SOL SERVER NATIVE CLIENT FOR MICROSOFT SOL SERVER

Microsolt Corporation (or based on where you live, one of its affiliates)
licenses this supplement to you. If you are licensed to use Microsoft
SOL Server software (for which this supplement is applicable) (the
"software''), you may use this supplement. You may not use it if you

do not have a license for the software. You may use a copy of this
supplement with each validly licensed copy of the software. v

M View EULA for printing

Do you accept the terms of the pending License Agreement?

If you choose Don't Accept, install will close. To install you must accept
this agreement.

Accept |

 SonNet CMS Setup @

:D Insialing SOL Server 2005 Express Edition SP2..

i& SonNet CNS

[is)ed
Welcome to the SonNet CMS Setup Wizard™ -

The installer wil guide vou through the steps required Lo install the SonNet CMS on yous computer

WARNIHG Tmmummmumwwmwmmm
d duphcation f thez program, or any portion of &, may result in severe cril
«Dfrms'pmalm wﬂumnahmmmmmmww

NB It is important that the CMS installation be
completed prior to connecting the PC to the
receiver. Ensure that the PC on which you are
installing CMS is NOT connected to the receiver
until the installation is complete.

CMS is compatible with Microsoft® Windows XP
SP2 or later, Microsoft® Vista and Microsoft®
Windows 7. The CMS installation CD comes with
all required programme files and drivers, and
includes SQL Server 2005 Express Edition SP2.

NB You must be logged in to Windows with an
administrator level user account to install CMS
and SQL Server 2005 Express Edition SP2.

If SQL Server 2005 Express Edition SP2 is not
already installed on your PC, the following
installation will be executed.

When the SQL Server 2005 Express Edition SP2
installation window appears, read the EULA and
then click the <Accept> button.

The installation of SQL Server 2005 Express Edition SP2
continues until complete.

The next step in the installation procedure will display the
“Welcome to the SonNet CMS Setup Wizard. Click the
<Next> button to continue.
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Click <I Agree> and then the <Next> button to continue.

i& SonNet CMS

License Agreement ~ ~

Please take a moment to read the license agreement now. If you accept the teims below, click 1
Agree"”, then "Next". Dtherwise click "Cancel".

The matenal installed by this installer is Copyright Sontay Ltd 2009
No right to use or copy this material is granted by this installation package.

All usage nghts are govemed by the license agreement.

" 1 Do Not Agree

SonNet files are copied to your PC.

i& SonNet CMS @
—~

Installing SonNet CMS y

SonMNet CMS is being installed.

Please wait...
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Device drivers are required for the USB receiver connection.

To install these, click the <Next> button to continue.

Device Driver Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work

To continue, click Next.

[ Newt> | [ Cancel ]

=] 3

1% SonNet CMS

Installation Complete

SonMet CMS has been successfully installed
Click "Close" lo exit.

When the installation is complete, click the <Close>
button.

Pleass uze Windows Update to check for any crtical updates to the MET Framework.
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Starting CMS

When the receiver is first connected to a USB port and switched on, the device manager will detect a new
device. Follow these steps to install the drivers for the receiver.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will seatch for current and updated software by

the Windows Update Web site [with ypour permission].
Read our privacy policy

Can'Windows connect to Windows Update to search for
soltware?

(O Yes. this time only
() Yes. now and every time | connect a device
(%) [Ho. nol this time

Chck Mext to continue.

looking on your computer, on the hardware installation CD, or on

Select the option shown (“No, not this time”)

Found New Hardware Wizard

This wizard helps you install software for;

‘Wieless Sensor Receiver

') If your hardware came with an installation CD
&2 or floppy disk. insert it now.

What do you want the wizard to do?

®lnst omaticaly (Recom
(O Install from a list or specific location (Advanced)

Chck Next to continue.

Select the option shown (“Install the software
automatically”)

Next > Cancel

J

[ <geck ||

Software Installa
7N
.

The software you are installing has not passed Windows Logo
testing to verify its compatibility with Windows XP. (Tell me why
this testing is important )

C ing your install of this soft may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the soft dor for soft that has
passed Windows Logo testing.

| Conlinue Anyway | | STOP Installation |

If advised that the drivers have not passed Windows
Logo testing, or are not digitally signed, click “Continue

Anyway”

There are 2 drivers to be installed, follow the same procedure for both drivers.
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When CMS is started, the PC com port connected to the receiver USB port needs to be defined.

Using the drop-down list box, select Wireless Sensor Receiver.

Select COM port

COM Part COMS: (WSR75HEE) Wireless Sensor Receive

[ OK ]|_Qancel1

Importing a Saved Layout

When first run, CMS may also ask if the user requires a saved XML layout file to be imported. This is useful if an
existing layout has been saved on a site where the PC running CMS has been replaced.

New System Attached, Load Saved layout? E'E'

Look in: | () My Documents > OB

'Y ) Avanti
(€] ©)Bits and Bobs
MyRecent [ Jday2day
Documents (5] My Data Sources

B By

Deskiop _JPOF files

)5onNet.log
) Turbocad
My Documents
My Computer
.ﬂ File name: | v
My Network  Files of type: XML Format (" smi) v Cancel

If no layout file is required, click the <Cancel> button to continue, otherwise navigate to the saved layout file
to and click the <Open> button import it.
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The CMS Desktop Environment

The CMS desktop is divided into 2 parts, a textual hierarchical display

Hierarchical Display
'

# €4 Receiver
# & Routers

- T

# ¢* Unknown

and a graphical “map” display.

&% Sontay Radio Sensors System

File Options View
{ @
_~Map Display | - X
Receiver
Router Lib
At Studio
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&% Sontay Radio Sensors System

File Options | View |

(7] Textual Display

 Hierarchical Display Graphical Display
# t‘._g, Communications Log

= & Routers Configuration Log To enable the text display panel, from the menu bar choose <View>

! then <Textual Display>
@ & Router Read Receiver Log

e Q Router|
=) D Sensors -
] D Pavillion
@ 1 Library
@ L Atium
@ L Art Studio

To enable the graphical display panel, from the menu bar choose
<View> then <Graphical Display>

Logging On as an Administrator

&% Sontay Radio Sensors System To make any changes to device configuration or to create or modify
‘ File | Options  View _ the graphical display, you must first log on as an administrator. To do
Switch Admin Mode this, from the menu bar choose <File> then <Switch Admin Mode>

BExit

= &) Routers
@ & Router Lib
@ & Router At
= U Sensors
@ | Pavilion
& D Library
# 1 Atrium

¥ [ A Studio

F

Please Enter Password

Password : ,I The login box appears. Type in your admin level password. NB
The default admin level password is admin (case sensitive).
This can be changed once you have logged in.

I Ok ] [ Cancel ]

Changing the Administrator Password

Change Password 3]

Old Password

To change the admin password, from the menu bar choose
_ : <File> then <Change Password>. Enter the existing password,
Confirm Password | | | enter your new password and confirm. Click the <Update>
button to submit the change, or click <Cancel>.

New Password

[ Update | [ Cancel |
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To prevent leaving the CMS in an admin state when not supervised, the admin log-in status automatically
times out after the time set in the “Change Idle Time” setting expires. To disable this feature (not
recommended), or to change the timeout value, from the menu bar choose <Options> then <Change Idle
Time>

Change Idle Time 3]

Enable idle time out Removing the tick the Enable Idle Time Out box disables admin
Idle Time (Seconds) ']1 20 ~ | | timeout feature. The timeout value can also be changed.

¥

| 0K || Cancel |

Listing Devices

In the text display panel on the left of the window, a list of all devices on the network can be found. These
devices are divided into 3 main categories, receiver, routers and battery powered sensor nodes.

=) &“j, # €8 Receiver ® & Routers
9 MAC Address : AGAGABABAGABABAS = & Routers = [ Sensars
# 9 Analogue Channel Mapping = & Router Lib = P“::,c .
% LastUpdate : 20/02/2009 11:34:25 & MAC@"*_3A1M‘°‘ : Pm’“::::w '
& Runtime : 79 mins < Parent : Receiver o e ks
2 . P Status : Onfine
9 RF Channel: 14 2 Temperature : 3.2'C (Output 1)
5 Q Routers R NG00 TR 2 9 Last Update : 20/02/2009 11:18.47
# L Sensors < Link IQUGHV'“. % Link Qualty : 83
& @ Unknown % Runtime : 119 mins & Fuine: 120w
BRSNS Router 4t % Baltery: 452 runtime 70 mins)
9 MAC Address | A100000000000103 - e
2 Patent: Router Lib 9 MAC Address - A100000000000005
@ Status : Onne 2 Paent : Router At
P Temperature : 22.6°C (Output 10) % Status : Online
% Relative Humidity : 23% 2 Temperatwe: 132°C
% Last Update : 20/02/2009 11:44:26 < Relative Humdity : 6%
9 Link Qualty: 2 9. Sefpolnt: 46X
% Runtime - 81 mins % Last Update - 20/02/2009 11:18:57
1 D Sdriins 2 Link Qualty: 2

% Runtime : 75 mins
& Battery : 34% (untime B1 mins)
% 1] Atrium

# ¢* Unknown

Each category can be expanded to view more detail or collapsed to hide detail.

The “Unknown” category is initially populated by devices which are joining the network for the first time,
either by auto-commissioning or manual authorization. Devices are held in the unknown category until CMS
has determined the type of device trying to join (for example, a router or node) and which options, if any, are
fitted (such as setpoint). When CMS has determined this information, the device will then automatically be
placed in it’s appropriate category.

NB The hand held monitor will only ever appear in the Unknown category. This is normal.
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Changing Device Labels

Each device, when first depicted in the CMS, has a default label, such as “Routerl” or “Sensor2”. To give the
router a more meaningful label, right click on the router and choose <Properties>

- In the <Name> box, type in the
Router Properties @ new name you require and click

the <Change> button.

s || Analogue Channel Mapping

NB There is a limit of 10 ASCII

% Name: Router Lib ‘ characters for router names.

MAC Address: A100000000000101

Software Version

Paient: Receiver [AGABABGABABABABAB)
Status: Online

Link Quality: 64

Runtime: 131 mins

To give a sensor a more meaningful label, right click on the sensor and choose <Properties>

&® Sensor Properties E]

Statu | Configuration | Analogue Channel Mapping |
D Name: -Lihraly '
= ' = In the <Name> box, type in the
new name you require and click
MAC Address: A100000000000005 the <Change> button.
SoltwaraV or s Lt NB There is a limit of 10 ASCII
Parent: Router Art (A100000000000103) characters for sensor names.
Status: Online
Link Quality: 2
Runtime: 75 mins
Battery: 94% (runtime 61 mins)
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Viewing Device Properties

Hierarchical Display
= €4 Receiver
P MaCa

ddress : ABABABABABABABLE

=B % alogue Channel Mapping

P 1:
P 2:
P 4:
9 5:
P b
P 8:
2 10
P 2

Pavillion / Temperature
Atrium / Relative Humidity
Art Studio / Switch

sensorl4 / Temperature
sensor14 / Relative Humidity
At Studio / Setpoint

: Router Art / Temperature

: Pavillion / Temperature

P Last Update : 20/02/2009 11:35:55

2 Runtim

e : 81 mins

9 RF Channel: 14

# & Routers
# L Sensors

To view the current analogue output channel
mappings, expand the receiver in the text display.

S

-

MAC Address:
Software Version
Parent:

Status:

Link Quality:
Runtime:

Active Alarms:

. Analogue Channel Mapping

wor Uib The specific properties of any device can be viewed

A100000000000101

Receiver [ABABABABABAGABAB)
Online

64

131 mins

by right-clicking a device and selecting <Properties>
in the drop-down menu.

Available router properties are:

Parent (if applicable)
MAC address
Software version
Status

Link Quality
Runtime

Any active alarms
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i Sensor Properties @

Name: | Library

MAC Address:
SoftwareVersion
Parent:

Status:

Link Quality:

Battery:

Temperature:

Relative Humidity:
Setpoint

Active Alarms:

2 Receiver Properties

MAC Address:

Software Version

RF Channel:
Runtime:

Authorised Nodes:

| Status || Configuration | Analogue Channel Mapping |

A100000000000005

10.3

Router Art (A100000000000103)
Online

2

75 mins

94% (runtime 61 mins)

13.2°C
6%

48%

ABABABABABABABAS
1.2

14
103 mins

Router Lib - A100000000000101
Router12 - A100000000000102
Router At - A100000000000103
Pavilion - A000000000000001
Atrium - A100000000000002
Art Studio - A100000000000003
sensorl4 - A100000000000004
Library - A100000000000005
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Available sensor properties are:

Parent (if applicable)
MAC address
Software version
Status

Link Quality

Runtime

Battery level

Any measured values
Any active alarms

Available receiver properties are:

MAC address
Software version
RF channel used
Runtime
Authorised nodes



Authorising a new node

Authorised (add) a new node E3

MAC address :-

Device Mams :-

[ OK ] LQ_ancel l

To manually authorise a new node(s), you must be logged on
at administrator level. From the menu bar, click on <Options>
and then select <Authorise (add) a new node> from the drop-
down menu.

You will need to make a note of the unique 16-digit MAC address of the new node, found on the label on the

device. Ensure the new device is powered on.

Authorised (add) a new node X

MAC address - |A100000000000008

Device Name - | Sensor 9

[ ok || cancel |

Removing a node from the network

De-authorise (remove) node X

Select Group :- “Sensoss v

Select Device: | YNNG

[ Rerove ][_Qancel I

Enter this MAC address and a device label into the appropriate
box fields and click <OK> to submit the details, or click
<Cancel> to discard the information.

To remove a node from the network, from the menu bar, click
on <Options> and then select <De-authorise (remove) node>
from the drop-down menu. Select the device group (routers or
sensors) and then select the device by name (label).

Click <Remove> to submit the details, or click <Cancel> to discard the action.
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Using the Graphical Map Display

Apart from the text hierarchical display, the CMS offers a graphical environment which allows users to quickly
determine how the network is functioning.

By default, there is no graphic image set as a backdrop for the map display.

A typical image to use for the map display would be a floor plan of the environment in which the radio
network has been installed.

Setting The Map Display Background Image

To set a background image for the map display, you must be logged on at administrator level.

% Sontay Radio Sensors System

Options | View

Authorise (add) a new node
Remove Authorised Node

Set Background Image

Change Port Name From the menu bar, click on <Options> and then
&= Change Idle Time select <Set Background Image> from the drop-down
+ Change Password mend.
=] D Change Update Time
& Configure Communication Log
@ Set Traffic LogFilter
+ E Atrium
@ 3 Art Studio
Select Background Image File @lz]
Look jrc | (3 Radio Sensor CMS v O i@
JBackgrounds
__J driver
Recent logs
@ Browse to the image file required. Image file
et formats currently supported are:
3 Bitm .bm
Y, ap (-bmp)

My Documents JPEG (Jpg)

File pame: 0 X
.'td Files of lype: Background Image File [ bmp:" ipg v

[ Open as jead-onky
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Adding Devices To The Map Display

To add a device to the map display, simply “drag-and-drop” a device from the text hierarchical display onto the
graphic background.

Add the receiver to the graphic first, then routers followed by battery powered nodes. Links are automatically
generated, showing the true network architecture.

Different icons are used to depict the receiver, routers and battery powered node, making identification easy.
The icons also depict the status of the device, and change to reflect whether a device is OK, off-line, or in
alarm.

Icon Plan

A schedule of what each icon and icon colour can be quickly found from the menu bar, click on <Help> and
then select <lcons> from the drop-down menu.

The following pop-up window is displayed:

N A

r

Receiver

OK

®
S

Sensor out-of-limits

Error

Low Battery
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Device Status

A quick check on a device status can be made by hovering the mouse cursor over a device on the map display.

7 [

Name : S_Factory
Tempersture : 20.7°C
Batrey Leved: 70%

Displayed parameters are device dependent, but include:

Device name (label)
All sensor values
Battery level (battery devices only)

>

NB Where link quality, hours run and battery level are shown in italics, this denotes that a request for data has
been sent to a device, but the device has not yet responded.

Link Status

The link status is represented graphically by the colour of the link drawn.

L £

Siiod Green: Indicates good link quality.

@ Receiver

Marginal

Red: Indicates marginal link quality.

A quick check on any link status can be made by hovering the
mouse cursor over a link on the map display.

Link Quality: Good
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Auto Updating

The CMS can be configured to update at a user configurable rate.

Auto Update

From the menu bar, click on <Options> and then select <Change Update
Time> from the drop-down menu. Adjust the update time accordingly.
Click <OK> to submit the change, or click <Cancel> to discard the
change.

From the menu bar, click on <Options> and then select <Change Update
Time> from the drop-down menu. Remove the tick from the <Auto
Update> box. Click <OK> to submit the change, or click <Cancel> to
discard the change.

Manual Refreshing Of Data

Node or network data can be manually refreshed. This is an important feature when re-connecting the CMS to
an existing network.

Hierarchical Display o x
B l';“é, Recewver
= & Routers
= % Router Lib
9 MAC Addeess : A100000000000101

When re-connecting the CMS to a receiver on an existing network, data
will only be refreshed to the CMS as and when a device updates it’s
information by timed transmission.

% Parent: Receiver
2 Status : Online
% Last Update : 20/02/2003 11:55:26 To ensure all data is sent as soon as possible, use the Refresh Node
% Link Qualty : 64 Information or Refresh Network Information options.
% Runtime : 130 ming
5 Q = B . .
Authorise (add) a new node To manually refresh node data, right click on a node and then select
De-authorise (remove) node <Refresh Node Information> from the drop-down menu.
Delete node from Map
Refresh Node Information To manually refresh network data, right click on a blank space (on the
Ping text or graphical display) and then select <Refresh Network
Eroperties Information> from the drop-down menu.

Refresh Network Topology

Print
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Communications Log

The CMS can keep a log of all communications on the network. This can be helpful in finding faults or
diagnosing network problems.

By default, the communications log is enabled. If you want to disable this feature,

Configure Communication Log @

From the menu bar, click on <Options> and then select <Configure
Communication Log> from the drop-down menu. Remove the tick from
the <Enable Communication Log> box. Click <OK> to submit the
change, or click <Cancel> to discard the change.

To view the communications log, from the menu bar choose <View> then <Communications Log>. A window
will appear at the bottom of the main CMS window. To close this view, click the cross in the top right of the
communications log window.

Communic. 0
FReceiver : Pending Address: A100000000000005 Function: ChidLOI A
Receiver : RawPacket -0x00 Ox44 0x40 DxA1 0x00 0x00 0x00 0x00 000 000 0x02 0x81 0x7E
Receiver : Pending Address: A100000000000002 Functior: ChidLQI
|Receiver : RawPacket -0x00 0xAS 0x40 Ox&1 000 000 0x00 0400 000 0x00 0x03 0x81 0x81
Receiver : Pending: Address: A100000000000003 Function: ChidLOI
|Receiver : RawPacket -0x84 0x70 0x60 0x41 0x00 000 0500 000 000 0401 0x03 0x00 0xBC 0xC2 0x06
Receiver : Complete : Address: A100000000000103
CGTWMRW ParentLOI, Router = tue

eceiver : RawPacket -0x84 0x71 0x60 OxA1 0x00 0x00 0x00 0x00 000 0x01 0x03 0x00 Dx14 0x14 003
_Fleoewei: Pending Address: 4100000000000103 Function: ChidLOI
Receiver : RawPacket -0x81 Ox7E 0x60 OxA1 0x00 0x00 000 0x00 0x00 0x00 0x05 0x00 0x14 0x14 Ox64
Receiver : Pending: Address: A100000000000005 Function: ChidLOI
Receiver : RanPacket -0x81 0x7E 0460 0xA1 0x00 0x00 0x00 0x00 0x00 0x00 0x02 0x00 Ox14 0x1A 0x64

Pending Address: A100000000000002 Functior: ChidLOI
Receiver : RawPacket -0x81 0x81 0x60 0xA1 0%00 000 0%00 0x00 0x00 0x00 003 000 Ox1A Ox1A OxFF
Receiver : Pending: Address: A100000000000003 Function: ChidLOI
|Receiver : RawPacket - - Event :0x00 0x04 0xB1 0wA0 0x00 0x00 0x00 000 000 0x00 0x01 0x0C DxB0 0x84
I‘r'leceivee: - Event :Complete: Address: ADD0000000000001 Function: MeasurementData
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Configuration Log

The configuration log allows the user to view a concise list of any changes made to the configuration of
devices. To view the communications log, from the menu bar choose <View> then <Configuration Log>.

¥l Configuration Log

OFom [20/m22008  v| To [20/m2/2009 | Keyfield A1 v [ Refesn ]

»

| 20/02/2009 0823 ConfiguationChanged  Meas Interval 10 Temparature:0.2 Meas Interval 60 Temperature:0.2 | 4000000000001
| 20/02/2009 10:27 | OutputMaphnalogue | FFFFFFFFFFFFFFFF Funclioncl) 4 A100000000000003 Funclion Setpointeasurement | Channet 8
| 20/02/2009 10:28 | ConfiguationChanged | Meas Intervat 10 Temperature:0.4 RH: 10 Setpoint20 | Meas Intervak 300 Temperature:0.3 RH:10 Setpoint 10| A100000000000003
| 20/02/200910:30 OutpuiMapAnalogue | A100000000000003 Funclion Setpaint | FFFFFFFFFFFFFFFF FunctionUnmapped [Channets
| 20/02/200910:30 | OutpuMapnalogue | 1000000000000 Funcion Setpoint | FFFFFFFFFFFFFFFF Funcion Unmapped | Channet?
| 20/012/20091030 | OutputMapinalogue | A100000000000003 Funclion Setpoint | FRFFFFFFFFFFFFFF FunctionUnmapped | Channet@
| 20/02/200310:30 OuiputMapénalogue | FFFFFFFFFFFFFFF FunctionU d | A100000000000003 FunclionSelpointeasurement | Channet8
| 20/02/2003 1207 | OutpuitMaphnalogue | FFFFFFFFFFFFFFFF FunctionUnmapped | A100000000000003 Funciion:TemperatureMeasurement | Charnet3

Results show can be filtered to show only specific “key fields” such as when a configuration was changed, or
analogue output mappings.

Results can also be filtered within a user-definable date range.

¥ Configuration Log

[Fom [19/02/2003 %| To |27/02/2003 % | KeyField (A1 v [ Refiesh |

TConfigate KegField Oldvakie NevwValue Description
2 (9 10:27 | OutputMapéinalogue : : 0003 + g
| 20/02/200310:30 | OutpuMaphnalogue | .
| 20/02/2009 10:30 | DutpuiMapdnalogue " " FFFFFFFFFFFFFFFF FunctiortJ

| 20/02/200910:30 OutputMapinalogue A | i o | FFFFFFFFFFFFFFEF Funcion U

| 20/02/200910:30 OutpuiMapdnslogue  FFFFFFFFFFFFFFFF Funclion Unmapped | A100000000000003 Funclion SelpointMeasurement

| 20/02/2009 1207 OutputMaphnalogue | FFFFFFFFFFFFEFFF FunclionUnmapped | A100000000000003 Funcion T emperatureMeasurement | Channet3
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